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Impor t ing  C l ient  Transact ion  Data  
f rom TD AMERITRADE VEO
OverviewThis document explains how to import client transaction data from TD AMERITRADE VEO.

What is the process 
for importing 
transactions?

Before importing client data for the first time, you need to do the following:

• Export transactions, security information and account information from VEO
• Decide whether to use Morningstar’s price for securities, or TD AMERITRADE’s
• Initialize the positions for your clients’ holdings from VEO, and
• Set up and apply a Portfolio Accounting System setting for imported data. 

Going forward, you will need only to export client data, then import it into Office Edition. You 
will not need to create a Portfolio Accounting System setting each time you want to import, 
and you will not need to initialize the positions after the first import.

Why do I need to 
initialize positions?

The purpose of initializing positions in Office Edition is to establish a baseline of holdings for 
your clients before you import data. That way, if the initial import should call for a client to 
sell out of a security, it will not come into Office Edition as a negative holding.

For instance, say a client owns 100 shares of Microsoft on June 1st, and sells all 100 shares 
on June 2nd, for a transaction of -100 shares. If you simply imported that sell data from 
June 2nd, without first initializing the ownership of the 100 shares on June 1st, in Office 
Edition it would look like the client had a position of -100 shares of Microsoft, when really he 
has no shares.

How often should I 
be exporting and 
importing data?

It is strongly recommended that you export from your custodian on a daily basis, either 
manually or through your custodian’s automated export tools. This ensures that fixed 
income prices or other prices not supplied by Morningstar will be imported, that all 
transactions are captured, and that reconciliation is easier and less time-consuming. 
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Exporting Data from TD AMERITRADE VEO Overview
Exporting Data from TD AMERITRADE VEO

OverviewThis section explains what data is needed to export from TD AMERITRADE VEO. Please 
contact TD AMERITRADE at 800-431-3500 if you need assistance exporting from their 
system.

File types neededYou must export data from VEO in TD Waterhouse format. You will need the following 
files:

YY = year; MM = month; DD = day.

If you are using PortfolioCenter, your files will be in the following format:

YY = year; MM = month; DD = day.

File Name File Type

TDYYMMDD.TRD Client/Account

TDYYMMDD.POS Position

TDYYMMDD.PRI Price

TDYYMMDD.SEC Security

TDYYMMDD.TRN Transaction

File Name File Type

ADYYMMDD.BCC Client/Account

ADYYMMDD.POS Position

ADYYMMDD.BAP Price

ADYYMMDD.BAC Security

ADYYMMDD.BAK Transaction
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Exporting Data from TD AMERITRADE VEO Downloading files from TD AMERITRADE VEO
Downloading files from 
TD AMERITRADE VEO

To download files from TD AMERITRADE VEO, do the following:

1. Log in to TD AMERITRADE VEO.
2. From the menu, select Tools...File Downloads...File Downloads.

3. The File Downloads page opens. Under Date Range, in the From and to boxes, enter 
start and end dates.

It is recommended that you go as far back as possible to get the most data.

4. If there is more than one advisor on your account, click the Advisor drop-down and 
select the advisor code whose files you want to download. All Advisors is selected by 
default.

5. From the File Type drop-down, select TD Waterhouse.

6. Click Search. Files appear in the File List area. 
7. To select all files, click the checked box icon at the top of the file list.

Select Tools...File Downloads...File Downloads

Select the Date Range

Select the Advisor

From the File Type drop-down, select TD Waterhouse

To select all files, click the checked box icon
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Exporting Data from TD AMERITRADE VEO Downloading files from TD AMERITRADE VEO
8. Click Download selected files.

9. The Browse for Folder dialog opens. Navigate to the folder where you want to save the 
files and click OK. 

10. The File Download dialog appears, showing the status of the download. When the dialog 
closes, the download is complete.

Click Download selected files

Select a destination folder and click OK.
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Exporting Data from TD AMERITRADE VEO Preparing TD AMERITRADE VEO files for importing
Preparing TD 
AMERITRADE VEO files 
for importing

TD AMERITRADE VEO exports files to your computer in .EXE format. Before importing 
into Office Edition, you must open these .EXE files in order to obtain the necessary file 
types. To get the properly formatted files, do the following:

1. Open the folder you selected when you when you exported from VEO.
2. Select all the .EXE files and click <ENTER> or right-click and select Open.

You do not need to open the filelog.txt file.

3. You might see a warning regarding the number of files you are opening. Click OK.
4. Several windows will open as the files are expanded. They should close automatically, 

but you might need to close these windows.

Obtaining a complete 
TRD file

Before initializing in Office Edition, you must have a complete client/account file with 
the extension .TRD containing all your clients’ names and addresses. TRD files are 
included in the standard file download from VEO, but these files might not contain all of 
your clients’ names. If you initialize without a complete TRD file, account numbers will 
be used in the place of missing client names. 

To determine whether you have a complete client/account file, open the TRD file(s) 
from your download folder using Notepad. If you do not see all your clients’ names 
listed, you need to request a complete TRD file from TD AMERITRADE customer 
service. Call 800-431-3500 and select option 3.

Select all .EXE files and click <ENTER>
or right-click and select Open
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Using the Set Country List feature Overview
Using the Set Country List feature

OverviewThis section explains how the process of security identification works during importing, 
and how to set default parameters to speed the import process. 

How does  Advisor 
Workstation Office 
Edition recognize a 
security from the import 
source?

When importing securities into Advisor Workstation Office Edition, the import process 
attempts to automatically map your imported securities to Morningstar-tracked 
securities, allowing you to take advantage of Morningstar’s extensive research 
capabilities. A number of system rules are involved in the security-matching process. 
Some rules are configurable, and others are not. 

Morningstar-tracked securities are stored in different security type universes (US 
Mutual Fund, US ETF, US Stock, International Stock, etc.). If security type information is 
provided by your import source, the process attempts to match that security to a 
Morningstar security in the corresponding universe. 

For example, if your import source categorizes your imported security as an Exchange-
Traded Fund, the process will look only in Morningstar’s ETF universe for a potential 
match. If a security is found, the process creates the mapping. If no match is found, or 
if your import source does not provide a security type, the process will search across all 
Morningstar universes. 

What if multiple 
matches are found for a 
security? 

Morningstar tracks securities globally. In many cases, the same security is traded on 
many exchanges throughout the world. Therefore, you will occasionally receive a 
“Multiple Securities Found” message in the Securities blotter. When you encounter this 
error, you can double-click on the error icon, which launches a security selection 
screen. This screen displays the results of the security-matching search. Here, you can 
select the security that best fits your needs.

Due to your securities trading all over the world, receiving this “Multiple Securities 
Found” error over and over again can become a nuisance. Therefore, you can configure 
your security matching process by manually selecting the countries where your 
securities may be trading.

By default, all US users have “USA” included in their Country List.  For most US users, 
this means that you’ll simply select “USA” from this list.  If you intend to import 
securities traded on exchanges outside the US, you can add other countries to your 
Country List.
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Using the Set Country List feature Selecting the US in your Country List
Selecting the US in your 
Country List

To select the US on your Country List, do the following:

1. On the universal toolbar, click Import.  The Import window opens.

2. From the File menu, select Set Country List. The Set Country List dialog box appears.

3. Check the box next to USA. 

4. Click Save + Close to save your changes.

Select File...Set Country List

Check the box next to USA
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Using the Set Country List feature Adding other countries to your Country List
Adding other countries 
to your Country List

To add other countries to your Country List, do the following:

1. On the universal toolbar, click Import.  The Import window opens.

2. From the File menu, select Set Country List. The Set Country List dialog box appears.

3. Click Add/Remove Country. The Select Countries dialog box appears. 

Select File...Set Country List

Click Add/Remove Country
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Using the Set Country List feature Adding other countries to your Country List
4. Click to highlight the name of the country you want to add to the list, then click Add.

You can select multiple countries at once by holding down the <CTRL> key as you click on 
country names.

5. To change the order of your country list, click the up and down arrows. 

The security matching process will pick the first match from the selected country list 
according to your selected order. This creates a user-defined country filter and will cut down 
on the number ‘Multiple Securities Found’ errors you receive.  

6. Click OK. You are returned to the Set Country List dialog box.
7. Check the box(es) next to the name(s) of the country or countries you added.

8. Click Save+Close to save your changes.

Click the name of the country 
you want to add, then click Add

Use the up and down arrows
to reorder your list

Check the box next
to the country name
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Selecting a Price Source for Imported Transactions Overview
Selecting a Price Source for Imported Transactions

OverviewThis section shows you how to choose whether to use Morningstar’s or TD 
AMERITRADE’s prices during both initialization and with all subsequent imports. You 
need to set this selection only once, but you must do it before you initialize a client’s 
positions, or you will end up using the default setting (Use Morningstar Price). 

If Morningstar does not track a security, Office Edition will use the imported price. Morningstar 
does not track fixed-income securities, options, closely held securities, CDs or UITs. 

Also, note that this is a global setting, and will apply to all new clients. If you plan to 
use Morningstar’s prices, you can skip this section and go page 11.

How to select a price 
source for imported 
transactions

To select a price source for imported transactions, do the following:

1. From the Tools menu, select Settings…Set Default Account Settings. A dialog box 
appears.

2. To use TD AMERITRADE’s prices, uncheck the box marked Use Morningstar Price. If 
this box remains checked, the Morningstar price for securities will be used when 
importing client positions.

3. Click OK to save the setting.

Select this option 
to choose the price source 
for securities when importing.

Uncheck this box 
to use TD AMERITRADE’s 
price for securities 
when importing.
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Initializing a Client’s Positions in Office Edition Overview
Initializing a Client’s Positions in Office Edition

OverviewIf you are importing for the first time, you most likely need to initialize your data. The 
only time you do not initialize is when you have the complete history of your firm saved 
in a format (delimited) that can be imported into Advisor Workstation. 

Unless you have just started your practice, though, you will begin with the positions, 
transactions, accounts, and prices as of a recent date. Additionally, initialization 
automatically creates a user-defined security for cash, to handle the transactions of 
buying and selling that take place as a result of the import process.

Note: Initialization is done only once. This process establishes a position against which the 
transactions will be able to post. This position will be the ending market value as of the 
initialization date.

After you initialize, your data will appear on a series of import blotters showing you the 
accounts, positions, transactions, prices, and securities for your clients. You will need 
to review the data on the blotters for errors before posting to your practice. 

What are blotters?Blotters are accounting spreadsheets where information is listed for your confirmation 
before importing. When viewing the blotters, you can search for and correct errors 
before posting the data to your practice. Office Edition has the following six import 
blotters: 

• Accounts
• Positions
• Transactions
• Prices
• Securities, and
• Reconciliation. 

During initialization, you need to review only the Transactions and Securities blotters for 
specific items. These are discussed below.

Navigating and saving in 
the blotters

When the import blotters first appear, and when you toggle from one blotter to another, 
it is important to wait until the blotters have completely loaded before clicking in them. 
When the status bar at the bottom of the screen disappears and the toolbar icons are 
no longer grayed out, the blotter is loaded. 

After making changes to a blotter, be sure to save your work by clicking the Save icon 
at the top of the blotter window. If you do not save your work in one blotter and you 
navigate to another blotter, your changes will be lost. 
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Initializing a Client’s Positions in Office Edition Importing for the first time (Initializing)
Importing for the first 
time (Initializing)

To initialize positions, do the following:

1. From the toolbar at the top of the Office Edition window, click Import. The Import 
window appears. 

2. Check the box next to TD Waterhouse. 
3. On the Action Shortcuts toolbar, click Initialize Positions. 

4. The Import dialog appears. From the File Name field, select the folder on your computer 
where you have saved the files you exported from TD AMERITRADE VEO.

5. Select the date to begin. 

Note: You can also click Get earliest date if your files are complete from that date forward. 

On the Action Shortcuts toolbar,
click Initialize Positions

Click here to use 
the earliest date available.
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Initializing a Client’s Positions in Office Edition Reviewing the Transactions blotter for errors
6. Click Initialize. You are taken to the import blotters, which are divided into the following 
categories: 
• Accounts
• Positions
• Transactions
• Prices
• Securities, and
• Reconciliation.

When initializing, only the Accounts, Transactions, Prices and Securities blotters will be 
populated. The Reconciliations blotter might have data at this point, but you can ignore it.

Reviewing the 
Transactions blotter for 
errors

When the import blotters appear, the Transactions blotter should be selected by 
default. For some custodians, recently traded but not yet settled securities appear as 
failed transactions after initialization.

Do the following to check for and correct errors on this screen:

1. Wait for the blotter to load. When the status bar goes away and the toolbar is no longer 
grayed out, the blotter is loaded.

2. Double-click the Status column header to check for errors.

You might need to double-click the header again to re-sort and display errors at the top of the 
list.

3. If you see a red error symbol in this field, scroll to the right and review the Error 
Message field. When an error message states “Not enough shares to post against,” 
confirm these transactions are in fact sales by consulting TD AMERITRADE’s records or 
client statements. 

4. Check the box next to the transaction(s).
5. Click the Delete icon on the toolbar.

Reviewing the 
Securities blotter for a 
cash position

To confirm that a cash position will be entered in the system for all subsequent import 
transactions, do the following:

1. Select Securities from the left side of the Import screen.
2. Wait for the blotter to load. When the status bar goes away and the toolbar is no longer 

grayed out, the blotter is loaded.
3. Sort by Security Type by double-clicking the Security Type column header.
4. Look for a Security Type of Cash and a Security Name of CASH. If this is not present, 

skip the “Creating a New Portfolio Accounting System Setting” section on page 17. You 
will need to complete that step in the process after you have done your first import, at 
which point the CASH position should be properly entered.
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Initializing a Client’s Positions in Office Edition Reviewing the Securities blotter for holdings with the wrong security type
Reviewing the 
Securities blotter for 
holdings with the wrong 
security type

Some security types might not have mapped properly. For example, options or VA’s 
might be mapped to Other, or CDs might be mapped to Cash. 

To resolve mapping issues, do the following:

1. On the Securities blotter, click in the Security Type field for an item that is mapped 
incorrectly.

2. Select the correct security type from the drop-down list that appears. That mapping 
will now be used for that security in all accounts where it is used.

3. Click Save. Your changes are saved.

VA’s will not be mapped during import. In addition to changing the security type from Other to 
VA, you must manually map them by clicking the magnifying glass in the Morningstar Mapped 
Holding column in the Securities blotter. 
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Initializing a Client’s Positions in Office Edition Reviewing the Securities blotter for double-mapped securities
Reviewing the 
Securities blotter for 
double-mapped 
securities

To ensure that all of the securities have mapped to the correct holdings in Office 
Edition, do the following:

1. Select Securities from the left side of the Import screen. 
2. Wait for the blotter to load. When the status bar goes away and the toolbar is no longer 

grayed out, the blotter is loaded.
3. Double-click the Status column header. If you see a red triangle here, the system is 

telling you that a security from TD AMERITRADE VEO is being mapped to two securities 
in Office Edition. You must decide which security to use. 

You might need to double-click the header again to re-sort and display errors at the top of the 
list.

4. Double-click the red triangle. A new window appears.

5. Check the box to the left of the item to which you want to map the security. If the proper 
match is not listed, click Save As User Defined. The holding will be saved as a user-
defined security. 

6. Click OK. The new window closes, and the red triangle no longer appears on the 
Securities blotter. 

7. Click Save.

Double-click this icon 
to correct the mapping 
for this security.

Check the box  
to the left of the item
to which you want 
to map the security
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Posting initialized 
positions to your 
practice

After you have reviewed the blotters and corrected the necessary items, do the 
following:

1. From any of the blotters (except Reconciliation), click the Post to Practice button. This 
posts the information from all blotters and creates the clients and transactions. The 
process could take several minutes.

You do not need to check the box next to an item’s name to have it post; all items will post 
automatically when you click Post to Practice.

2. A confirmation message appears, informing you that the import data was successfully 
posted to your client accounts. Click OK.

You might instead see a message that reads “The data in the following blotter(s) haven’t 
posted completely: (name of blotter)”. When you click OK, unposted data appear in the 
blotters. Check the blotter referenced in the message and check for errors.

3. Go to the Practice tab in the main Office Edition window, and confirm that the client and 
account data is now present.

After making corrections, 
click Post to Practice
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Creating a New Portfolio Accounting System Setting

OverviewAfter initializing, but before you import client data, you need to create a new Portfolio 
Accounting System setting called Import. This allows for any manual transactions you 
might post to an imported account to not automatically update dividends and stock 
splits.

If you have transaction accounts that you do not import, you can set the appropriate system 
setting for handling dividend, splits, etc., at the account level. Contact Morningstar’s support 
desk with any questions.

You cannot perform this step if a CASH position was not created as part of the 
initialization process. If a CASH position was not created, this might be because the 
accounts had no unsettled cash on the date of initialization. You will have to return to 
this section after your next import from TD AMERITRADE VEO.

How to create a new 
Portfolio Accounting 
System setting

To create a new Portfolio Accounting System setting, do the following:

1. From the Home tab in Office Edition, select the Settings page. 
2. Under the Portfolio Accounting System Settings area, click once on Reports, Tax Lot 

Methods, Transactions, Management Fees. The Settings pop-up window appears.

3. From the toolbar, click New Setting…New Transactions Setting.

Click once on this 
option from the
Settings page.

Select this option.
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4. In the Setting Name field, type Import. 

You can name the setting anything you want, but it is recommended to name it Import so it is 
clear this setting should occur only for accounts you are importing.

5. In the Default Cash Symbol field, click the magnifying glass icon. The Add Default Cash 
Symbol dialog opens.

6. Click the Within drop-down and select User Defined Cash. 

7. Click Go.
8. In the Available Records box, select CASH.
9. Click OK. You are returned to the Transaction Setting window. Do not select any check 

boxes on the dialog box.
10. Click Save + Close.
11. Click OK when the save confirmation message appears.
12. Close the Settings window.

Type Import

Click the Within drop-down and select User Defined Cash.
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How to apply the new 
transaction setting

To apply the import transaction setting you created, do the following:

1. From the toolbar at the top of the Office Edition window, click Tools and select  
Settings...Set Default Account Settings. The Set User Default Settings window 

appears.
2. Click the Transactions drop-down menu and select Import.

3. Click OK.
4. Click OK when the confirmation message appears.

From the Tools menu, select 
Settings...Set Default Account Settings
 

Click the Transactions drop-down 
menu and select Import
Version 1.0 19



Ongoing Importing from TD AMERITRADE VEO Overview
Ongoing Importing from TD AMERITRADE VEO

OverviewThis section explains how to import data from TD AMERITRADE VEO after the 
initialization has been done and the Portfolio Accounting System setting has been 
created and applied.

Remember, if a CASH position was not created as part of the initialization process, you will 
have to return to the “Creating a New Portfolio Accounting System Setting” on page 17 after 
your next import.

Importing from TD 
AMERITRADE VEO

To import data from TD AMERITRADE VEO, do the following:

1. From the toolbar at the top of the Office Edition window, click Import. The Import 
window appears. 

2. Double-click TD AMERITRADE. The Import dialog opens.
3. Select the folder on your computer where you saved the files you exported from TD 

AMERITRADE VEO.
4. If this is your first import after initialization, in the Start Date field, enter the date after 

initialization. 

For example, if you initialized as of January 15, 2007, your start date should be 01/16/2007. 

5. If this is not your first import after initializing, in the Start Date field, enter the date after 
your last end date. 

Keep track of the date ranges for your imports so you do not enter the same date more than 
once. If your start date is the same as or earlier than your last end date, this will create double 
entries and the accounts will be out of balance.

6. Select an End Date. It is recommended that you not import more than a week’s worth 
of transactions at a time.

7. Click OK. The information will now appear on the import blotters.

Reviewing the import 
blotters

After the files are imported to the blotters, you need to review each blotter to ensure all 
of the data posts correctly. 

All blotters now have information, except for Accounts, which has information only 
when a new account is being created. If you see any accounts you previously imported, 
it is possible those accounts were copied, or the account numbers were changed. 
These accounts might need to be re-mapped in order to ensure the transactions post 
with the correct account. Please contact our Support Desk with any questions 
concerning mapping clients.
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Reviewing the 
Securities blotter

Review the Securities blotter to ensure all security types are correct. Change any 
security types (Other) to the appropriate type, if applicable. To change a security type, 
do the following:

1. Click in the Security Type column. A drop-down menu appears.

2. Click the on the appropriate type. The selected type populates the cell. 
3. Click Save.

Reviewing the 
Transactions blotter

Review the Transactions blotter to see if any transactions were rejected. Double-click 
the Status column header to determine if any transactions were rejected. You might 
need to double-click the header again to re-sort the column and display error messages 
at the top of the list.

Transaction types and amounts can be edited on the blotter, but some fields cannot be 
edited. These transactions might need to be deleted and manually entered from the 
Account screen under the Practice tab. A transaction could be rejected because:

• The custodian did not properly code the transaction
• Advisor Workstation does not recognize the code being sent from the custodian, or
• The transaction code from the custodian requires manual intervention (a transaction 

that might impact cost basis, etc.). 

Note: Be sure to save the edits you make prior to posting the transactions. Without saving, 
the changes will not be processed.

Click in the Security Type
column and select the correct type.
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Handling Reconciliations after Importing

OverviewIn this section, you will learn how to use the Reconciliation blotter to resolve 
transactions that are out of balance.

Reviewing the 
Reconciliation blotter

Once the import blotters are loaded, click Reconciliation on the left side of the Import 
screen. The Reconciliation blotter opens. 

Reconciling the positions you are importing could take several minutes, depending upon the 
number of transactions and positions in your practice.

All positions are displayed on the Reconciliation blotter. All out of balance (OOB) 
positions are at the top, sorted by largest first, and highlighted either in red or blue. 

Items in red indicate that the custodian recognizes a position, but Office Edition 
recognizes a different position (either no position or just different).

Items in blue indicate that Office Edition recognizes a position, but the custodian does 
not. This occurs with some custodians with cash.

Editing posted 
transactions in the 
Reconciliation blotter

To edit a posted transaction in the Reconciliation blotter, do the following:

1. Right-click the specific exception and select View Transaction.
2. A new window opens, displaying both posted transactions (transactions previously 

posted) and pending transactions (those transactions that are in the transaction blotter, 
but not posted to the accounts). 

You can also log on to TD AMERITRADE VEO and compare their record of transactions to 
Office Edition’s to find discrepancies between the two systems.

3. You can edit posted transactions from the Reconciliation blotter, but not pending 
transactions (See “Editing pending transactions in the Reconciliation blotter” below). To 
edit a posted transaction, right-click the exception and select View Transaction.

Right-click an exception
and click  View Transaction
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4. Posted transactions open in a new window. Right-click the transaction and select Edit.

5. The transaction opens in a new window. Make your changes and click Save and Close.
6. You are returned to the Transactions window. Close it by clicking the red close icon or 

selecting Close from the File menu.
7. You are returned to the import blotters. Click Reconciliation again to refresh the blotter 

and display your changes.
8. When importing a date range, you are also able to select past dates to which to 

reconcile by clicking Reconcile Historical Date. This allows you to better determine 
when the OOB occurred and why.

Note: You can reconcile historical dates only as far back as the date range you imported. For 
example, if you imported from 03/01/2007– 03/31/2007 during a session, you can view the 
Reconciliation blotter only between those dates.

9. After all issues have been reconciled, click on any of the other blotters.
10. Click Post to Practice.
11. A dialog appears, confirming that the data has been posted. Click OK.

You might receive an error message stating that data has not posted. Click OK and you are 
taken to the Transactions blotter. Scroll to the right to the Error Message column to review the 
cause of the error.

Editing pending 
transactions in the 
Transactions blotter

You can only edit pending transactions in the Transactions blotter. To edit a pending 
transaction, do the following:

1. Click Transactions on the left-hand side of the Import screen. The Transactions blotter 
opens. 

2. Edit the transaction type, transaction date, amount, number of shares, and/or 
price. 

3. Once you have made your edits, on the Action Shortcuts toolbar, click Save.
4. Click Reconciliation to re-open the Reconciliation blotter and view the results of your 

edits.  

Right-click the
transaction and 
click Edit
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Adding transactions 
from the Reconciliation 
blotter

You might need to add a transaction to bring your accounts into balance. To add a 
transaction from the Reconciliation blotter, do the following:

1. Right-click an exception and select View Transaction. 

2. A new window opens, displaying both posted transactions (transactions previously 
posted) and pending transactions (those transactions that are in the transaction blotter, 
but not posted to the accounts). 

3. Right-click a transaction and click New.

4. The Transaction Wizard opens with the Security Name, Client Name and Account 
Name fields populated.

Right-click an exception 
and click View Transaction

Right-click a transaction
and click New.
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5. To change the security, in the Security Name field, click the magnifying glass icon. 

6. The Add Security dialog opens. Locate the security and click OK.
7. Click the Transaction Type drop-down and select the transaction you want to add.

8. More data fields appear. The fields vary, depending on the transaction type selected. Fill 
in the blue fields.

9. Click Save+Close to save the transaction and return to the Transactions blotter or 
Save+New to save the transaction and add a new transaction.

In the Security Name 
field, click the
magnifying glass icon. 

Select the 
transaction type
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Deleting transactions 
from the Transactions 
blotter

You might encounter duplicate transactions in the Transactions blotter. To delete a 
transaction from the Transactions blotter, do the following:

1. Check the box to the left of the transaction.
2. On the Action Shortcuts toolbar, click Delete.

3. A dialog appears, asking you to confirm that you want to delete the transaction. Click 
OK. The transaction is removed from the blotter.

On the Action Shortcuts toolbar, click Delete
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Troubleshooting Import Issues

OverviewYou might encounter a variety of issues when importing data. This section walks you 
through five common scenarios:

• Dealing with a client’s cash position during the import process
• Resolving issues related to an institution’s proprietary ticker symbol for a security
• Correcting errors that occur as a result of a date being skipped during importing
• Manually entering transaction types, and
• Handling investment name changes.

Working with cash 
positions when 
importing

Office Edition is a trade date system. Due to this, we use cash as an offset to every 
transaction that is generated by the custodian. This is to ensure the market value is 
correct on trade date. Office Edition credits cash to an account on the trade date for 
each sale, and debits cash to an account for each buy. 

Office Edition also credits cash first for any deposits from a client into an account, as 
well as from cash interest and dividend payments. Fees are always taken from cash.

Do not delete cash transactions or cash holdings. This will cause an out of balance 
situation in your account, and will impact performance measurement.

Troubleshooting issues 
with a unique share 
class

Some custodians market a certain class of mutual fund that is unique to their firm. In 
other words, XYZ mutual fund might allow Schwab to market a fund that is specific to 
their investors, which might have the load waived. 

This type of security is imported with a different, user-defined ticker. No user-defined 
ticker can appear on a Quicktake report. Therefore, these securities need to be mapped 
to a security recognized by Office Edition. You can do this when importing the securities 
from the custodian. Do the following:

1. Click on the Securities blotter.
2. Scroll to the Morningstar Mapped Holding column.
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3. Double-click the magnifying glass icon.

4. The Find Securities dialog opens. Click the Within drop-down and select Open End 
Funds. 

5. Locate the fund whose performance you want to map to your user-defined security.
6. Highlight the desired fund and click OK.  The Find Securities dialog closes and the 

Morningstar Mapped Holding and Morningstar Mapped Name columns are populated.
7. Click the Save icon at the top of the blotter window to save your mapping.

Double-click the magnifying glass
to map a holding to a mutual fund
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Troubleshooting a 
skipped file date

Skipping a date when importing causes your accounts to be out of balance. For 
example, if you import from 03/01/2007 to 03/03/2007, and then from 03/08/2007 to 
03/10/2007, you will be out of balance for all of the days you skipped.

To determine if you have skipped a date, do the following:

1. Click on the Reconciliation blotter.
2. Right-click an exception and select View Transaction. 

3. Check the posted transactions against the custodian’s records. If you find transactions 
that have posted according to your custodian, but have not posted or are pending in 
Office Edition, you might have skipped a date. 

4. Follow the steps for ongoing importing (see Importing from TD AMERITRADE VEO on 
page 20) and enter the skipped date as both the start date and the end date.

A note on transaction 
types

Some transaction types received from TD AMERITRADE VEO might not be recognized 
in Office Edition. Therefore, you might need to process certain transactions to balance 
your positions.

Transaction exceptions might also be due to corporate actions (spin-offs, stock 
mergers, reverse stock splits, etc.) that must be manually entered. For a complete list 
of transaction types available in the Transactions blotter, see the “Transaction Types” 
topic in Office Edition Help.

Right-click an exception and 
select View Transaction
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How investment name 
changes are handled for 
user-defined securities

When a name change occurs on a Morningstar-tracked security, Morningstar updates 
the ticker and/or CUSIP number, usually within a week. Once the update is done, you do 
not need to manually update the ticker and/or CUSIP.

However, when a name change occurs on a user-defined security, you must edit the 
CUSIP and/or ticker. To change the name of a user-defined security, do the following:

1. From the main Office Edition screen, click the Tools menu and select Edit Definition 
Master. The Definition Master opens.

2. In the left-hand column, click Securities.
3. Click in the Symbol and/or CUSIP column(s) and enter the new information.

4. Click Save. You can now close the Definition Master. 

Enter new name 
information in the 
Symbol and/or
CUSIP column(s)
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When the name of a user-defined security changes to the name of a security followed 
by Morningstar, you can map the security in the Definition Master. To map to the 
Morningstar-tracked security, do the following:

1. From the main Office Edition screen, click the Tools menu and select Edit Definition 
Master. The Definition Master opens.

2. In the left-hand column, click Security Mappings.
3. Scroll to the right and click in the Use As Substitute column next to the security and 

select Yes.

4. Click on the magnifying glass icon in the Morningstar Ticker column. The Find 
Securities dialog box opens. 

5. Locate and select the Morningstar security.
6. Click OK.
7. Click Save. You can now close the Definition Master.

In the Use As Substitute 
column, select Yes.
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